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Disclaimer and risk warnings 
All contents of this manual are neither an endorsement, nor a solicitation of any sort, and 

cannot be considered as a promotional offer. All information you receive is unsolicited, private 

encoded communications of privileged, proprietary, and confidential information for you only 

and by purchasing the given product you agree to keep this information private, confidential, 

and protected from any disclosure. You also agree to indemnify and hold harmless the authors 

of this product, their employees, contractors, and service providers. Should any of the practices 

described herein turn out to be unlawful in any jurisdiction, individuals pursuant to its 

legislation should restrain from any intentions or attempts to apply them in any manner, either 

personally or in partnership with other individuals or entities. Unauthorized copying and 

distribution of all or any parts of this manual or product are strictly prohibited and will result in 

civil liability and criminal charges brought against the violators and their aides. 

 

U.S. Government Required Disclaimer - Commodity Futures Trading Commission. Futures and 

Options trading has large potential rewards, but also large potential risk. You must be aware of 

the risks and be willing to accept them in order to invest in the futures and options markets. 

Don't trade with money you can't afford to lose. This is neither a solicitation nor an offer to 

Buy/Sell futures or options. No representation is being made that any account will or is likely to 

achieve profits or losses similar to those discussed on this web site. The past performance of 

any trading system or methodology is not necessarily indicative of future results. 

 

CFTC RULE 4.41 - HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE CERTAIN 

LIMITATIONS. UNLIKE AN ACTUAL PERFORMANCE RECORD, SIMULATED RESULTS DO NOT 

REPRESENT ACTUAL TRADING. ALSO, SINCE THE TRADES HAVE NOT BEEN EXECUTED, THE 

RESULTS MAY HAVE UNDER-OR-OVER COMPENSATED FOR THE IMPACT, IF ANY, OF CERTAIN 

MARKET FACTORS, SUCH AS LACK OF LIQUIDITY. SIMULATED TRADING PROGRAMS IN GENERAL 

ARE ALSO SUBJECT TO THE FACT THAT THEY ARE DESIGNED WITH THE BENEFIT OF HINDSIGHT. 

NO REPRESENTATION IS BEING MADE THAT ANY ACCOUNT WILL OR IS LIKELY TO ACHIEVE 

PROFIT OR LOSSES SIMILAR TO THOSE SHOWN. 



3 
 

Table of Contents 

1. Foreword 

 

2. Getting started 

 

3. Step 1 - Installing Forex Sensation Extended 

 

- 1st Method 

 

- 2nd Method 

 

4. Step 2 - MetaTrader4 Configuration 

 

5. Step 3 - attaching Forex Sensation Extended to a chart  

 

6. Forex Sensation Extended settings explained Updated! 

 

7. Forex Sensation Extended on-chart messages 

 

8. Forex Sensation Extended Strategy Test 

 

9. Troubleshooter 

 

10.  How to stop trading 

 

 

 

 

 



4 
 

1. Foreword 
Thank you for purchasing Forex Sensation Extended. This manual will help you install, 

activate, and use your software with maximal profit and minimal trouble. 

 With the purchase of your Forex Sensation Extended, you gained access to our 

members’ area, with this manual and all required files available for download there. It is of a 

high importance that you download all required software files to your computer and save them 

in a handy place to be able to use them during the installation process. The Forex Sensation 

Extended can be installed in two different ways – to facilitate finding the necessary files for 

both methods you can check with this list: 

 For the 1st method: 

ForexSensationExtendedSetup.exe 

 

 For the 2nd method: 

  ForexSensationExtended.ex4 

  ForexSensationExtended.dll 

 

You can choose only one method, which suits you better. It is also essential that you 

have these files to proceed with setting up your Forex Sensation Extended copy. We 

recommend saving them to your desktop for your convenience. 
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2. Getting Started 
 The first thing you need to do after downloading the files is decide which broker you are 

going to trade with. In this manual, we will describe the installation on the example of 

MyFxChoice, but should you choose a different broker, don’t worry, as Forex Sensation 

Extended works fine with other brokers too, and the installation is rather similar. 

 Before running Forex Sensation Extended on a live account, we recommend that you get 

acquainted with it on a demo account beforehand. The subsequent pages of this manual 

describe how to register a demo account first. 

 To open a DEMO account with MyFxChoice, please, go to the following URL: 

https://my.myfxchoice.com/registrationDemo/, submit all the requested information in the 

registration form, select “Forex Sensation Extended” in Account field and then click the 

“Submit” button, as shown below:  

 

You can select any MT4 option in the Account section. 

Register Live Account at MyFxChoice and get 15% Deposit Bonus for Forex 

Sensation Extended! 

Next, you will receive a confirmation email from MyFxChoice, with your demo account login 

details and a link to the page where you can download the MyFxChoice MetaTrader4 platform.  

https://my.myfxchoice.com/registration/?ib=16663
https://my.myfxchoice.com/registrationDemo/
https://my.myfxchoice.com/registration/?ib=16663
https://my.myfxchoice.com/registration/?ib=16663
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To begin with the installation, click on the MetaTrader4 download link in the body of your 

email. 

As soon as the page loads on your screen, a dialogue box will appear prompting you to save the 

setup file to your computer. You can Save it to your computer by clicking on “Save File”: 

  

If you decide to save it to your computer, you will also have to select a directory where to save 

the setup program. For your convenience, we recommend you to save it to your Desktop: 

 

After the installer file downloads to your computer, you will most likely be asked for a 

permission to run it. This is the Windows built-in security, and you should confirm any 

messages for the program to be able to install correctly. 
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You might also see warnings from your antivirus system – since such software is heavily coded 

to prevent reverse engineering, it might be taken as a virus by some security systems, which are 

for some reason unable to detect the difference between such security measures and true 

malware. What should they do if they see such warnings? That instruction needs to be 

included. 

During the installation process you should be prompted consequently to the below windows. 
 

 

Click “Next >”. 
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Then you will be prompted to select the path into which you wish to install your MetaTrader4 

platform and the name of the Start Menu program group.  We recommend that you leave it 

default, which is the most convenient path option.  

 

 
 

Important:  Make a note of the installation folder path – you will need to know the location 
later in order to install Forex Sensation Extended. 
 
Click “Next” after you have decided on your path, and the setup program will place all the 

necessary MetaTrader4 files into the selected directory. After the installation is finished, click 

on “Finish”, and run your MetaTrader4. 

When MetaTrader4 starts up for the very first time, you will need to log in with your Demo 

account details that you have received in your MyFxChoice registration email. We highly 

recommend noting them down to be able to access your demo account later from other 

platforms. 

https://my.myfxchoice.com/registration/?ib=16663


9 
 

 

 
Normally, you will be presented with a login screen immediately upon opening your trading 
platform for the first time. Should you need to log in again, you can click on “File” > “Login”. 
Here, enter the login and password for your demo account, select the FXChoice-Demo server 
option, and click on “Login”. Make sure that you select the correct server, as the demo login 
credentials issued to you earlier will only work in conjunction with the FXChoice-Demo server. 
After you click on the “Login” button, your account will be logged in automatically, and your 
MetaTrader platform will be ready to go. 
 
After doing that, please, be sure to CLOSE the MetaTrader4 window. All installations should be 
performed when your trading platform is closed, otherwise you might face a series of problems 
in the installation process. 
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3. Step 1 - Installing Forex Sensation 

Extended 

1st Method 
 

This is the recommended and most convenient method to install Forex Sensation Extended. To 
install it this way you will need only one file: 
 

- ForexSensationExtendedSetup.exe 

To Avoid errors during the installation, make sure the folder /experts/presets/ exists in your 

Metatrader 4 folder. If there’s no such folder, please create one: 

 

You will need to find the ForexSensationExtendedSetup.exe file on your computer and run it 

by double left-clicking on the respective file icon: 

 

The first window of the installation will prompt you to agree to the Software License 

Agreement. Confirm it by clicking on “I agree”: 



11 
 

 

At the next stage, the setup program will try to find any existing copies of MetaTrader4 on your 

computer, and provide you with their list. If you do not see your MetaTrader4 on the list, you 

can add it manually, by clicking on “Add”, and selecting the folder in which it is located, in our 

case – FX Choice MetaTrader 4. Please bear in mind that it is crucial to select only the root 

folder of your MetaTrader4 – not the experts or libraries folders. 

                       

After you add your MetaTrader4 folder to the list, make sure it is highlighted and displayed in 

the top field as well: 

https://my.myfxchoice.com/registration/?ib=16663
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Finally, click on “Install”, and you will see the “Installation was completed successfully” 

window. 

                       

Just click on “Close” at the bottom of the window and you are ready to proceed to the second 

step. 
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2nd Method 

Important: Use the second method of the Forex Sensation Extended installation only if the first 
method doesn’t work or produce errors. Though it is a classic method of installation, it is more 
complicated and is used only in cases where the automated setup doesn’t work. 
 
To use this method, you should find the following two expert files on your computer: 
 

 
 
And 6 preset files: 
 

 
 

Do not open any of these files – they are not executable and should be pasted according to the 
following instructions: 
 
Step 1. First of all, you need to copy the ForexSensationExtended.ex4 file into the necessary 
folder. You can begin by right-clicking on the file icon and selecting “Copy” in the drop-down 
menu that will pop up: 

 
 

Step 2. Next, you will have to remember the folder where your MetaTrader4 is installed. For 
MyFxChoice, with the default installation options you can find it at C:/Program Files/FX 
Choice MetaTrader 4/.  This path varies with different brokers, so we highly recommend noting 
down the path during the respective stage of your MetaTrader4 installation process. 
Also, in some cases, and in particular, if you are running a 64-bit Windows version, the 
Program Files folder might look like “Program Files(x86)” or “Program Files”. 

https://my.myfxchoice.com/registration/?ib=16663
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If you experience any problems locating your platform, you can hold your mouse cursor over 
the MetaTrader4 icon for a few seconds, and a pop-up will show you the correct path. 

 
Step 3. Now that you have found the necessary path to your MetaTrader4 folder, you can open 
“My Computer” or “Computer” for Windows 7 or Vista. That should open the built-in 
Windows Explorer application, which allows you to browse your computer files system. 
 

 
 

On this example, you can see how we proceed to the “experts” folder by double-clicking on all 
subsequent folders specified in the path we determined earlier. 
Step 4. First double click on Local Disk (C:).  
 
Step 5. then click on Program Files: 
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Step 6. Then click on the FX Choice MetaTrader 4 folder: 
 

 
 
Step 7. After you get to the MetaTrader4 folder, it is very important that you open the 
“experts” folder. 
 

 
 

Step 8. Here, you can paste the file by right-clicking on any empty space and selecting “Paste” 
in the dropdown menu. 
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Step 9. After you paste the ForexSensationExtended.ex4 file into the “experts” folder, in the 
same folder (i.e. the experts folder) locate the “libraries” folder.  

 
 
 
 
Click on the “libraries” folder, and locate the ForexSensationExtended.dll file and repeat the 
previous instructions from Step 1 to Step 8 in relationship to the ForexSensationExtended.dll 
file. 
 
Then Locate “presets” folder inside your “experts” folder, open it and copy 3 preset files 
there: 
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4. Step 2: MetaTrader4 Configuration 
 

Once you have finished installing the Forex Sensation Extended files, the next thing to do in 
MetaTrader4 is to go to the Tools –> Options menu: 

This step is critically important for backtests as well as for saving much trouble with setting up 
your software copy every time you run it. 
 
All you have to do here is click on the Expert Advisors tab and ensure that the boxes are 
checked exactly as shown below:  
 

 
 
Do not overlook the “Confirm DLL function calls” option (which should be unchecked) - 
otherwise the Forex Sensation Extended will not be able to function properly.  
You may also wish to uncheck “Disable experts when the account has been changed” and 
“Disable experts when the profile has been changed” options, though this is more of a 
convenience rather than a requirement. After you have checked all needed fields, click “OK”. 
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5. Step 3: Attaching Forex Sensation 
Extended to a Chart 

 
Having installed Forex Sensation Extended, restart your MetaTrader4 platform and check the 
Navigator panel on the left-hand side of the MetaTrader4 window. Clicking the small [+] to the 
left of “Expert Advisors” will expand that section and change the [+] to a [-] to display all 
installed products: 
 

Do not worry that the Forex Sensation Extended icon is 
gray in this list, whilst all other icons are colored. This is 
normal for all commercial software. A colored icon means 
that you have the “source code” for that particular file.  
 

If you cannot find the Forex Sensation Extended icon on 
this list, it is most probable that you have installed it into 
an incorrect directory. In that case, we would 
recommend carefully going through step 1 of the 
installation process again. Also, this happens very often 
when you have several MetaTrader4 platforms installed 
on your computer. Check the folders and reinstall it into 
the correct folder. Or you might have simply forgotten to 

restart your MetaTrader4. 
 
 
After you install all of the Forex Sensation Extended files, 
and locate the Forex Sensation Extended icon on the 
Navigator panel, you need to open the chart with the 
feed necessary for the Forex Sensation Extended to 
trade. For Forex Sensation Extended, it is the EURUSD 
and GBPUSD charts. To open a new chart, simply click 
on “File” and select “New Chart”. You will then be 
prompted to select the desired currency pair in the 
drop-down menu that will instantly appear. Select the 

EURUSD or GBPUSD chart. 
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After opening the required chart (EURUSD or GBPUSD), you need to select the M15 timeframe. 
To do this, click on the chart, and then click on the M15 button in the top horizontal toolbar of 
your MetaTrader4 window: 
 

 
 

After you have the necessary chart opened and the M15 timeframe selected, you can start 
attaching it to the chart. 
 
In this manual, we will explain how to attach Forex Sensation Extended to the EURUSD chart. 
You easily can repeat same actions for GBPUSD. 
 
Note: The Minimal Account Balance should be $500 or more per currency pair  
 
To attach the Forex Sensation Extended to a currency chart:  on the Navigator panel, right-click 
on the Forex Sensation Extended icon and select “Attach to a chart” in the menu as it is shown 
below: 
 

 
 
When you attach the Forex Sensation Extended to the chart, the “Properties” dialog window 
will open. The dialog window contains two tabs – “Common” and “Inputs”. 
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The “Common” tab looks like this: 
 

 
 
It is crucial that all three of the settings highlighted within the red frame are matching the 
image above or Forex Sensation Extended will not function properly. 
 
Also, pay special attention to the “Confirm DLL function calls” checkbox which should be 
unchecked. Assuming that everything else is correct, the “Inputs” tab looks like this: 
 

 
If you scroll down this inputs section, you will be able to see a number of adjustable settings, 
which are explained in the following several pages of the manual. If you wish to change any of 
the settings, just double-click in the “Value” field of the desired setting, and enter the new 
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value. To apply the changes, click OK, this will restart Forex Sensation Extended with the new 
settings. Remember to enter your Code (your license key) in the respective field.  
 

Before trading you should apply correct Settings Preset 
for appropriate currency pair. 

 
In the Inputs window click on “Load” button: 
 

  
 
Then select appropriate “.set” file from /experts/presets/ folder and press “Open”: 
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For example for EURUSD pair it could be one of four: FSE_EURUSD.set, 

FSE_EURUSD_LowRisk.set, FSE_EURUSD_MediumRisk.set, 

FSE_EURUSD_Aggressive.set). Each of the presets is explained in this section. 
 
It’s very important to select correct .set file for each currency pair. 
 
Now we are ready to start trading.  
 
Depending on how well you have followed our instructions so far, there will be one of three 

possible things displayed in the top-right corner of the chart to which the Forex Sensation 

Extended is attached: 

- Smiley face indicates that the software is correctly installed and 
ready to trade.  
 

- X means that you forgot to enable the Expert Advisor trading in 

MetaTrader4. Make sure that the big Expert Advisors button  on the top 
toolbar of MetaTrader4 is hit.  
 

- Sad face indicates that you did not allow live trading. Just press F7 
and make sure that the “ALLOW LIVE TRADING” checkbox is checked!  
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6. Forex Sensation Extended Settings 
Explained 

 
Default settings are saved in preset (.set) files, that are installed in /experts/presets/ folder 
 
FSE_GBPUSD.set - Default settings for GBPUSD. 
FSE_GBPUSD_Aggressive.set - More Aggressive settings. This set will increase target profits for 
S1, so the overall risk increases as well. 
FSE_EURUSD.set - Default settings for EURUSD. 
FSE_EURUSD_LowRisk.set - Low risk settings with two strategies (S1 and S4). 
FSE_EURUSD_MediumRisk.set – All strategies active, but Risk setting reduced for risky 
strategies (S2 and S3). 
FSE_EURUSD_Aggressive.set - All strategies active. S3_Aggressive is active. 
 
Settings: 
 
Code – This is your license number and it is used by the Forex Sensation Extended to ensure that you are 
not using a pirated copy of this product. You can find this code in the email message, which was 
dispatched to you immediately after you made the purchase or withing the members area. It is very 
important that you have a valid Code, as without this setting the Forex Sensation Extended will not be 
able to function at all. 
TesterGmtOffset - the GMT offset which will be used during the robot’s backtest. The GMT offset is 
detected automatically for live trading. 
MaxSpread - maximal spread with which the trading is allowed.  
NewsFilter - news filter. Disables the trading during the important news release that can impact the 
market’s volatility. Also, the possibility of a manual disabling of the trading by our analysts is foreseen if 
the market situation is regarded as dangerous for trading. Set to “true” by default.  
 
S1 - if set to “true”, the first strategy will be enabled. The strategy is based on an algoritm searching for 
a pattern correction. The market entry is done in the direction of a more global trend, at a price rollback 
(correction).  (by default = true) 
S1_Risk - the risk setting determining the lot size with regard to the initial deposit. It is recommended 
not to use a value higher than 0.5. (The ultimate risk setting is 0.2) 
S1_AdaptiveLot - Lot size will be recalculated based on the StopLoss size. The bigger the StopLoss the 
smaller the lot size will be set. This feature will reduce the risk. (by default = false) 
S1_Lots - lot size which will be used for the trading if Risk is set to 0. (The ultimate risk is 0.1) 
S1_TakeProfit - the first strategy’s take profit when S1_AdaptiveTPk = 0 (by default = 10) 
S1_StopLoss - the second strategy’s take profit when S1_AdaptiveSLk = 0 (by default = 30) 
S1_AdaptiveTPk - the take profit calculation coeficient (by default = 1) 
S1_AdaptiveSLk - the stop loss calculation coefficient (by default = 3) 
S1_MinStopLoss - the minimal stop loss (by default = 20) 
S1_MinTakeProfit - the maximal take profit (by default = 5) 
S1_MaxStopLoss - the maximal stop loss (by default = 100) 
S1_MaxTakeProfit - the maximal take profit (by default = 30) 
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S2 -if set to “true”, the second strategy will be enabled. The strategy follows a trend. When the market 
movement gains a rather strong traction, a trade is placed in the direction of the trend.  
S2_Risk - the risk setting determining the lot size with regard to the initial deposit. It is recommended 
not to use a value higher than 0.5. The ultimate risk setting is 0.2. 
S2_AdaptiveLot - Lot size will be recalculated based on the StopLoss size. The bigger the StopLoss the 
smaller the lot size will be set. This feature will reduce the risk. (by default = true). 
S2_Lots - lot size which will be used for the trading if Risk is set to 0. 
S2_MinStopLoss - the minimal stop loss (by default = 20) 
S2_MaxStopLoss - the maximal stop loss (by default = 40) 
S2_TakeProfit - the second strategy’s take profit (by default = 70) 
S2_TrailingStop - the second strategy’s trailing stop (by default = 20) 
 
S3 - if set to ‘true”, the third strategy will be enabled. The strategy trades at the most volatile time of the 
day placing a trade in the direction of an impulse.  
S3_Aggressive - the third strategy’s aggressive mode. If the aggressive mode is enabled, the strategy 
uses fewer filters, so a trade opens almost daily. If the aggressive mode is disabled, the strategy uses 
more sophisticated market entry rules that increase the trading’s precision yet decrease the number of 
trades. 
S3_Risk - the risk setting determining the lot size with regard to the initial deposit. It is recommended 
not to use a value higher than 0.5. The ultimate risk setting is 0.2. 
S3_AdaptiveLot - Lot size will be recalculated based on the StopLoss size. The bigger the StopLoss the 
smaller the lot size will be set. This feature will reduce the risk. (by default = true) 
S3_Lots - lot size which will be used for the trading if Risk is set to 0. 
S3_TakeProfit - the third strategy’s take profit (by default = 40) 
S3_StopLoss - the third strategy’s stop loss (by default = 20) 
S3_TrailingStop - the third strategy’s trailing stop (by default = 7) 
 
S4  - if set to ‘true”, the fourth strategy will be enabled. Strategy folows a trend after important news 
releases. 
S4_Lot - lot size which will be used for the trading if Risk is set to 0. 
S4_AdaptiveLot - Lot size will be recalculated based on the StopLoss size. The bigger the StopLoss the 
smaller the lot size will be set. This feature will reduce the risk. (by default = true) 
S4_Risk - the risk setting determining the lot size with regard to the initial deposit. It is recommended 
not to use a value higher than 0.5. The ultimate risk setting is 0.2. 
S4_TakeProfit - the fourth strategy’s take profit (by default = 40) 
S4_StopLoss - the fourth strategy’s stop loss (by default = 20) 
S4_TrailingStop - the fourth strategy’s trailing stop (by default = 10) 
S4_ThresholdK - Sensivity setting for opening trades, during high volatile news releases. Is the 
coefficient for average range of m5 bar (default = 1) 
S4_TimeThreshold - Time threshold for trading, after news release, 1 = 1 hour (default = 0.05) 
 
S1_Magic - the first strategy’s magic number.  
S2_Magic - the second strategy’s magic number. 
S3_Magic - the third strategy’s magic number. 
S4_Magic – the fourth strategy’s magic number. 
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7. Forex Sensation Extended On-chart 
Messages 
If you installed the Forex Sensation Extended correctly, the following on-chart message should 

automatically appear in the top left part of your chart: 

 

The version number displayed and the general content above will change over time as new 
versions are released and additional features are incorporated.  
 
Authentication status:  This message should display “Authenticated” if the software has 
verified the Code successfully and is functioning properly. 
 
Members Area Account:    This message should display your members area account login 
(email). 
 
ServerTime: Current time on your broker’s server. 
UtcTime: Calculated UTC time. 
 
Spread: Current spread for both 4-digit and 5 digit quotes. 
Leverage: Your account leverage. 
 
S1-3 Lot: Displays the lot size of the next trade that will be opened by each strategy. 
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8. Forex Sensation Extended Strategy 
Test 

 
If you want to do the strategy testing of the Forex Sensation Extended, you will need to have 
the historical data.  
Now let’s learn how to make a backtest with the My FX Choice broker. 

1. Open the FX Choice MetaTrader 4. 
 

2. Go to “Tools > History Center” then DOUBLE-Click EURUSD (or GBPUSD) under the 
“Majors-var” list, click 1 Minute(M), then click “Download” to begin downloading 
historical data. 

 

 

DONE! Now it is time to do the backtest! 
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Click the Strategy Tester button in the MetaTrader4 toolbar to open the window. 

 

 
  
The Strategy Tester will appear at the bottom of MetaTrader4. 

 

You should select Forex Sensation Extended from the list, the proper symbol (EURUSD or 
GBPUSD), the M15 period (timeframe). Choose the “Every Tick” model. 
Also set “Use Date” to test over a specific period in the past. 
We recommend you not to use the “Visual mode” for long time spans because the backtest will 

take much more time, but you will see a simulation of the trades being made on the currency 

chart. 

Important: To perform a backtest correctly, you need to specify the brokerage’s GmtOffset 

value manually in the Expert Properties menu as it is shown below. The GmtOffset for My Fx 

Choice on backtests is “1”, so you need to change it from 0 to 1 in the TesterGmtOffset  field. 

Note: You can ask you broker for the backtest GMToffset, coz it’s usually different from live 

trading GMTOffset. 

 
 
Click START to begin the test.  
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You may switch between the various tabs at the bottom of the Strategy Tester window during 
the testing. 
You can see the trades here: 

 
 
You can learn the detailed information about the current backtest in the “Report” Tab. 
Right-clicking in this window and selecting “Save as report” will create a detailed report of your 
testing. 
 

 
 
If your Strategy Test showed no trades, it means there were some errors. Check the Journal Tab 
to discover the problem.  
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9. Troubleshooting Q&A 
 

Q. Forex Sensation Extended is not working, what should I do? 

A. First of all, please, make sure that all installation steps from the manual were performed 

correctly. If you did not locate any errors in the installation process, have a look under the 

“Experts” and “Journal” tabs in the “Terminal” window of your MetaTrader4 to identify your 

problem. 

 

Q. I’m getting the error message “DLL calls are not allowed” what should I do? 

A. Please, make sure that under the Tools->Options->Expert advisors tab of your MetaTrader4 

platform the “Allow DLL imports” box is checked. If not, check it, confirm changes, and reattach 

the Forex Sensation Extended to the chart. Also, make sure that “Allow live trading” is checked 

and “Confirm DLL function calls” is unchecked, as these settings are also crucial for the Forex 

Sensation Extended’s trading. 

 

Q. I’m getting the error message “You've entered wrong Code” what should I do? 

A. This means you have forgotten to enter your authentication code or you’ve entered wrong 

Code. Click the smiley face icon or press F7 to open the Inputs tab and enter the correct code. 

 

A. What if I’m getting other errors? 

If you are experiencing any issues that are not covered in the knowledgebase or the user’s 

manual, please submit a support ticket providing as much detail as possible. Any screenshots or 

additional information will be appreciated. 
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10. How to Stop Trading 
There are several ways to stop the software’s trading.  
 

1) In case you use several products on your account and want to completely stop the 
trading of them all, click the green “Expert Advisors” button in the toolbar. Please, bear 
in mind that this action will also stop any other products that you may be running on 
your account.  
 

 
 

2) If you want to remove only one product, you can do so by right-clicking on the Smiley 
Face and choosing “REMOVE” in the menu.  
 

 
 

3) If you don’t want to remove the software, you can simply disable its live trading ability 
by pressing F7 and un-checking the “Allow live trading” checkbox: 

 
 


